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1 BACKGROUND

There is a need for an improved method for predicting post-mining water levels in
underground coal mining. The Surface Mining Control and Reclamation Act (SMCRA) permitting
requirements include estimating water levels post mining as part of characterizing the area
hydrology. The use of ‘top of coal’ has been proven, by flooded mines and recent hydrologic
research, to be an insufficient estimate of post-mining water level. As mine companies are
required by SMCRA to mitigate/remediate environmental impacts of flooded mines, this
insufficient estimation may cost companies money. More reliable prediction can save money on
post-mining reclamation by preventing the environmental impacts from happening to begin

with.

The goal of this project was to develop an empirical predictive model of post-mining water
level, implemented in ArcGIS Pro. Using data from the proposed underground coal mine permit,
the model returns points of predicted post-mining water levels and can be compared to a

Digital Elevation Model (DEM) to identify areas at risk of surface discharge from mine pools.

1.1  ORIGINAL DATA SOURCES

The project team requested public permit data from 28 permitted underground coal
mines in Ohio. Spatial, hydrologic, and geologic measurements were gleaned from the permits,
yielding usable data from 15 mines. Additional data and/or GIS layers were downloaded from
Ohio Department of Natural Resources, Division of Mineral Resource Management (ODNR-
DMRM), Geological Survey (ODNR-GS), and Water Resources (ODNR-WR), US Department of
Labor Mine Safety and Health Administration (MSHA), National Oceanographic and
Atmospheric Agency (NOAA), and Ohio Geographically Referenced Information Program
(OGRIP).

1.2  STATISTICAL ANALYSIS

Once gathered, multivariate data analyses were run using The Unscrambler X and

Neuroshell 2 to develop a prediction algorithm for post-mining water levels. The resulting



algorithm with the resulting error was included in the tool. Table 1 displays the selected
algorithm, with each variable transformation. Each of the variables required in the inputs for
running the tool are required due to their use in running the prediction algorithm. More details
on the analyses are provided in the three theses linked on the Mine Pool Study webpage of

watershedadata.com (http://watersheddata.com/MinePool Study.aspx).



http://watersheddata.com/MinePool_Study.aspx

Table 1 — Selected prediction algorithm

Polynomial Net (GMDH) Test 'K'

Best formula:

Y=0.1*X7-4.9E-002*X11+9.2E-002-2.1E-002*X4+1.9E-
002*X9+0.41*X1-1.1E-002*X3+6.5E-002*X6-0.1*X10+4.3E-
002*X5+0.56*X2-0.37*X12-0.38*X2/2+2.5E-002*X11"2-0.14*X23-
6.5E-002*X1113+0.84*X1*X2-0.24*X1*X11+0.36*X2*X11+3.2E-
002*X1*X2*X11-1.9E-004*X6/2+4.1E-002*X5*X6+4.3E-002*X7/2+4.E-
002*X1072-2.6E-002*X7/3+5.E-002*X1073-0.14*X7*X10-1.1E-
002*X972-1.6E-002*X973-2.5E-002*X2*X9+1.3E-002*X5"2-2.5E-
002*X6”°3-1.4E-002*X1"3+2.E-002*X1*X7+3.1E-002*X6*X10+2.7E-
002*X1*X3+1.4E-002*X9*X11+2.9E-002*X2*X4+1.3E-002*X8"3-1.6E-
002*X8*X11+6.7E-003*X4"2+4.5E-003*X1*X6

Variable Transformations:

X1=2.0*(Surface Elevation (msl) -545.0)/835.0-1.0

X2=2.0*(Bottom Coal Elevation (msl) - 244.04)/1055.96-1.0

X3=2.0*(Overburden Thickness (ft) -65.0)/638.1-1.0

X4=2.0*(Mined Coal Thickness (ft) - 0.07)/11.69-1.0

X5=2.0*(Shale/Clay Thickness (ft) - 0.35)/552.55-1.0

X6=2.0*Sandstone Thickness (ft)/262.3-1.0

X7=2.0*Limestone Thickness (ft)/204.97-1.0

X8=2.0*Total Coal Thickness (ft)/33.23-1.0

X9=2.0*Accumulative Coal to Extract (Mm~3)/138.61-1.0

X10=2.0*(Underground Mining in 4-Mile Buffer (acres)-
2061.0)/108987.5-1.0

X11=2.0*(Average Annual Precipitation (in) - 37.5)/3.7-1.0

Y=2.0*(Potentiometric Head (msl) - 400.0)/932.0-1.0

R squared:

0.9906

Mean squared error:

324.8997

Mean absolute error:

12.3227

Min. absolute error:

0.0014

Max. absolute error:

147.93

Correlation coefficient r:

0.9953




2 TOOL STRUCTURE

2.1 DATA FORMATS

For the tool to function smoothly, the completeness and formatting of the input data is
most important. The provided pre-formatted Excel Spreadsheets allow for inputting raw data
from proposed mine permit applications as specified and allow the tool to run correctly. Data
formats for each column must be followed exactly to ensure accurate data extraction when
imported to ArcGIS. All columns must be filled out with data and may not be left blank or

calculation errors will occur when the tool applies the prediction algorithm.

Consistent coordinate projections in collection of data is also necessary, or at least clear
recording of the projection used in collecting XY coordinates so the correct projection can be

selected when running the tool.

2.2 REQUIRED INPUTS
It is necessary for the user to gather and prepare site specific data for analysis of the
proposed mine. (See Section 4 for instructions on formatting.) The five required files are as

follows:

1) Well Excel spreadsheet: Permit/Mine ID, well ID, XY coordinates, potentiometric head
(ft msl), surface elevation (ft msl), bottom of coal elevation (ft msl), average annual
precipitation (in). Note: All elevations are in reference to mean sea level.

2) Borehole Excel spreadsheet: Permit/Mine ID, XY coordinates, overburden thickness (ft),
mined coal seam thickness (ft), shale/clay thickness (ft), limestone thickness (ft), total
coal thickness (ft), accumulative coal extracted (Mm”3).

3) Study mine: Shapefile of proposed new mine extent.

4) Abandoned Underground Mines (AUM): Shapefile of pre-SMCRA mined out extents.

5) Underground Mine Extents (UG): Shapefile of post-SMCRA mined out extents.



2.3 TOOL FUNCTIONS

Figure 1 displays the general flow of the ArcGIS Pro model built to extract variables and
apply to prediction algorithm to produce points of predicted post-mining water level. The
model runs these tools automatically. This graphic is provided for those interested in how the
model functions. The box on the left (START) displays the required user inputs, and the final box
on the right (END) displays the final output of the tool. In between the START and END boxes
are the tools used and the layers created by the model while extracting variables and applying

the prediction algorithm.

START
Required Work Flow for ArcGIS Tool - Fow ' Input shapefile

inputs Rebecca Steinberg 2/15/2019 O Tool @ Working shapefile

Spatial Join

Spatial Join

Buffer
(4miles)

END
Final outputs

Field
Calculator

Raster to
Point

Figure 1 — Work flow diagram that describes the layers and tools used in the construction of the tool in ArcGIS Pro Model
Builder.

2.4 DIRECT OUTPUTS
The tool produces four shapefiles that are automatically added to the map once the tool
is run: 1) well shapefiles, 2) borehole shapefiles, 3) calculated points, and 4) points of predicted

head compared to the area DEM. These outputs are further described in Section 5.



3 DOWNLOADING FILES

3.1  ZipPeD FOLDER
The ArcGIS Pro map package that hosts the prediction tool and the Excel data sheets are

available for download at http://www.watersheddata.com/MinePool Study.aspx as a zipped

folder. The “Mine Pool GIS Tool Package” folder _

Ly O5SM Mine Pool Study Executive Summi
(Figure 2) is a folder containing the download

B 2-page fact sheet

links for the Map Package

(Mine_Pool_Prediction_Model_Map.aptx), the

Mine Pool GIS Tool Package
Well Excel Spreadsheet, and Borehole Excel .

Spreadsheet. Prepare the Well and Borehole ine

Excel data sheets prior to opening the tool in -+ Ohio University Graduate Student Rese

ArcGIS Pro (Section 4). The map package contains -+ Lindsey Schafer, 2018, Statistical a
predict mine pool formation in und:

the prediction tool, script that runs the prediction
Figure 2 - Screenshot displaying the location of the

algorithm, shapefiles of surrounding underground download link to click on Watersheddata.com to
download the prediction tool.
mines, DEM, and default required layers as

examples.

Once the zipped folder is downloaded, navigate to the ‘Downloads’ folder, right click on the
zipped folder and select ‘Extract All..." (Figure 3). When the window opens, select a local folder
for saving the map package and data sheets. We recommend that you save all materials related

to the Mine Pool Tool in this same folder.


http://www.watersheddata.com/MinePool_Study.aspx

v‘ ThisPC > Downloads »
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Figure 3 - Screenshot displaying how to unzip the folder containing the project files

Size

5,657 KB
351KB
15KB
33KB
394,573 KB
33KB
2,098 KB
705KB
41,477KB
1,617 KB
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4 PREPARE DATA

Proper data preparation is essential for successful execution of the model. The user should
carefully read through the descriptions of the layers required to adequately prepare their data

for running the prediction model.

4.1 SHAPEFILES

Three GIS polygon shapefiles are required:

1) Abandoned Underground Mines (AUM): Ohio abandoned coal mines (Pre-SMCRA).
This layer is included in the tool Template, however, it is only current to the end
of 2018, when the layers were downloaded. This layer is created and maintained
by ODNR - DMRM. Tool users may want to verify that the layer has not been
updated, or re-download and replace the included shapefiles with the most
current versions from the ODNR Mines of Ohio interactive map

(https://gis.ohiodnr.gov/MapViewer/?config=OhioMines). Click the “?” icon in

the mine viewer application, then click the DATA tab to access downloads.

2) Underground Mine Extents (UG): Permitted mine extents (Post-SMCRA).
This layer is included in the tool Template, however, it is only current to the end
of 2018, when the layers were downloaded. This layer is created and maintained
by ODNR - DMRM. Tool users may want to verify that the layer has not been
updated, or re-download and replace the included shapefiles with the most
current versions from the ODNR Mines of Ohio interactive map

(https://gis.ohiodnr.gov/MapViewer/?config=OhioMines). Click the “?” icon in

the mine viewer application, then click the DATA tab to access downloads.

3) Extent of the proposed new mine: Shapefile of proposed mine extent, created from
maps and information in the permit application. The user may have to create this
shape if the shapefile layer is not already created or accessible from the data for

the permit application.


https://gis.ohiodnr.gov/MapViewer/?config=OhioMines
https://gis.ohiodnr.gov/MapViewer/?config=OhioMines
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Also required is a raster file Digital Elevation Model (DEM). For users in Ohio, the model

package comes with preloaded, State of Ohio 30M DEM.

4.2 DATA SHEETS

The tool also requires two data tables that must be compiled from permit data or
calculated from the data provided with the permit application, or other sources. Data used in
developing this model were hand-entered from PDF copies of paper mine permit files. Due to
the recent changes of the permitting process, (changing to an online, digital application)
locating the required data may vary from the paper-based method used in this project. The
digital permit application requires that same data as the paper application. The digital

application process may make it easier for the user to compile the necessary data.

The formatted Excel Spreadsheets are provided in the download folder at

http://watersheddata.com/MinePool Study.aspx (Download instructions in Section 3).

Special attention must be paid to units of entered data to assure that all values are
properly converted to the units specified in the provided formatted Excel spreadsheet files.
Likewise, consider the coordinate systems used in collection of XY data, and make sure all final
shapefiles and XY data are aligned in the same projection, as these tables will be plotted to
point shapefiles in the model process. All columns must have data for the tool to function, no
null or zero values. If the data collected does not have all values for variable in Excel

spreadsheets, do not include that point in the analysis.

1.) Well Excel Spreadsheet: sheet containing hydrologic data extracted from mine permits
used to predict post-mining water level by the ArcGIS tool
a. Permit/Mine ID, Well ID, XY coordinates, potentiometric head (ft msl), surface
elevation (ft msl), bottom elevation (ft msl): extracted from well logs and
materials submitted with the permit application. Note: Potentiometric head
values are input for the user to compare and validate to the output prediction.
b. Average annual precipitation (in): retrieved from various sources. The user can

check NOAA or other weather data collection entities to arrive at the best


http://watersheddata.com/MinePool_Study.aspx
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number for their location. If local rainfall values are not available, enter the Ohio
state annual average precipitation of 37.57 inches as a default.
2.) Borehole Excel Spreadsheet: sheet containing geologic data extracted from mine
permits used to predict post-mining water level by the ArcGIS tool

a. Permit/Mine ID, Borehole ID, XY coordinates, overburden thickness (ft), mined
coal seam thickness (ft): data directly derived from the borehole logs required
for the permit application.

b. Shale/clay thickness (ft), limestone thickness (ft), sandstone thickness (ft), and
total coal thickness (ft): calculated by adding together the associated layers from
the overburden to get a total thickness stratigraphic record. Only layers within
the overburden above the mined coal seam are considered.

c. Accumulative coal extracted (Mm”3): the volume of coal the mine is expected to

produce, which is a required value for the permit application.

When data collection for the formatted Excel well and borehole spreadsheets are complete
for the proposed mine, each spreadsheet must be saved as a comma separated value (.csv) file

(Figure 4). Save the .csv sheets to a local folder.



Save As

a

s
a

Save As
“— S » This PC » Vaoinovich ShareDrive (V3)

Organize * Mew folder

_J 3D Objects 2 Mame
[ Desktop

Documents

* Downloads
Jﬁ Music

[&] Pictures

E Videos

e Local Disk ()

= Voinovich SharelC

Authors:

# Hide Folders

Figure 4 — Screenshot to show saving the data Excel sheets as the correct file format: .csv (Comma delimited)
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5 STEPS FOR RUNNING THE TOOL

5.1 SETTING UP PROJECT DATA

When data detailed in Section 4 is compiled into the spreadsheets and saved in the local
folder, open the .aptx file in ArcGIS Pro by double clicking on the file, or by selecting “Open
Project” from the front screen of ArcGIS Pro. The map may take a bit of time to load the

template map and included layers.

Once the map package is opened and the project has been created, users can customize their
required data within the map. For Ohio Coal Fields users, The Underground Mine Extents (UG)
shapefile, Abandoned Underground Mines (AUM) shapefile, and the DEM for the state of Ohio
raster are already included in the table of contents, so the user will only need to add: 1) the

proposed mine shapefile; 2) the borehole .csv table; and 3) the well .csv table.

The “add data’ function in ArcGIS Pro (Figure 5) allows the user to locate the local folder

where files are saved and add them to the project.

BB ge-co- s

Project Map Insert Analysis View
A l
4 ’ AN/ e .
e L0

Explore AR ¥N Bookmarks Go
> v To XY
Clipboard Navigate f ;
Contents » 1 x i Catalog Dlﬂep X
T Search je)
1 g / B
= ] E + §

Figure 5 — Screenshot displaying the location of the ‘add data’ function in ArcGIS Pro to locate and add user input files.



15

First the user needs to add the shapefile of the proposed mine from the local folder using
the ‘add data’ function. Click ‘add data’, navigate to the local folder in the window that appears,

then select the shapefile and click ‘ok’ (Figure 6).

Feature Layer ArcGIS Pro - TestTempMap - Map
Edit imagery Share Appearance Labelng Data

=[] {E [_Vl [T Astributes a_ et ©1) Pause (“} yne
m % &] | == B8 i ViewUnpnced @

Add  Select Select By SelectBy Infographics Measure Locate Convet To  Downioad
Preset ~ *  Attributes Locmn - - & More - Annctation Map =

Inquiry Labeling Offine

‘g’mm
G[s)

!

Selection

g = al & \——| |
radoa | ocate local folder
© 5 @)[El» Project » Folders » Mine_Pool_Prediction Model Map # p12 » testtempmap.gdb » * |©)]| Seorch Project p

Organze * New item *

4 & Project Name Type
& Datadases 1> ] AUM _Mines File Geodatabase Feature Class
[ o Folders ] &5 oem Raster Dataset
4 & Portal File Geodatabaze Feature Class
@ My Content [ UG_Mines File Geodatabase Feature Class

@ Groups
O Al Portal

B Lnving Atlas

D Computer
s Desktop
= Documents
= Downloads

= Windows (C)

m \\shared.ohio.edu\vainowch (Vi)

Name | Example Propozed_Mine

16.244 | BR 3% & 473,436.95€ 4475, 269.65N m

Figure 6 — Screenshot displaying how to add a shapefile to the project map, example here showing the Example Proposed Mine
shapefile being added.
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Once added, the user shapefiles must be saved to the project geodatabase created by the
template project. Right click on the proposed mine shapefile (and any other shapefiles added) in

the table of contents and select “Export features” (Figures 7).

| Joins and Kelates ’
Contents b Cadinn . Map X 0 Model for Predicting...ater L
T l Search o, Zoom To Layer
I: ‘E/] E ; 4 B:']I‘ @ Zoom To Make Visible

Drawing Order

4 Map
4[] calc_pts_Spatialloin

|
: Selection »
‘ Label

> O |

¢ Labeling Properties...

,~ Symbology

Dist to Surface from Predicted Head

& <0.000000 i 'o Disable Pop-ups

@ £349.696280 @ Configure Pop-ups
4 [/] calc_pts

R Data » |[[,] Export Features

i Export Tabl

4[] borehole_pts Sharing » |E3 Export Table

£ View Metadata Rematch Addresses

4 V] well_pts # Edit Metadata
®
! @ Properties
A| Example_Proposed_Mine —— g

Figure 7 — Screenshot displaying how to find ‘Export features’ function so that user added layers can be saved to the Project
database or in the working Project folder.

Navigate to the project geodatabase in the window that opens, name the shapefile, and
save the shapefile in that location by hitting ‘run’ in the ‘copy features’ geoprocessing window

(Figure 8).
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~ | Geoprocessing -8 x
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4 = Project
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All Portal
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4 [[ Computer
Desktop
Documents
Downloads
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Feature Classes (Al Types)

487,517.65€ 4,468,027.59N m

|2 Catalog Geoprocessing  Symbology

Figure 8 — Screenshot displaying how to save the user’s shapefiles to the project’s geodatabase. ‘Export features’ in Figure 7
opens, ‘copy features’ in the geoprocessing window. Open the window for the ‘Output feature class’ to navigate to the project
geodatabase, provide a name in the window, click ‘save’, then make sure to click ‘run’ in the geoprocessing window.

Next the user needs to add the data sheets to the map, also using the ‘add data’ function

and steps outlined above (Figures 5 & 6). Once added, the user data sheets must be saved to the

project folder created by the template project. Right click on the .csv sheets in the table of

contents and select “Export table” (Figure 9).
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'T | Search
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Drawing Order
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4[] AUM_Mines
[=0]
4 UG_Mines
4 (/]| DEM

Value
469.199

129.08
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4 Standalone Tables
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Design 4
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Data
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Figure 9 — Screenshot displaying how to export data tables after they are added to the project map.

geoprocessing window (Figure 10).
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‘Export table’ opens ‘copy rows’ in the geoprocessing window. Navigate to the project

folder, enter a name in the format of “name.csv”, click ‘save’ and then click ‘run’ in the
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m x

Copy Rows

Figure 10 - Screenshot displaying how to save the user’s data tables to the project folder. ‘Export table’ in Figure 9 opens, ‘copy
rows’ in the geoprocessing window. Open the window for the ‘Output table’ to navigate to the project folder, provide a name in
the window, click ‘save’, then make sure to click ‘run’ in the geoprocessing window.

5.2 OPENING THE TOOL

Once the required inputs are added to the table of contents and saved to the project
locations, the prediction model can be opened from the project’s toolbox. The project’s toolbox
can be found in the Catalog tab several ways (Figure 11). If closed the Catalog tab can be
reopened from the “View” tab in the main ribbon at the top of the screen. The template

toolbox contains:

1) “Model for Predicting Points of Post-Mining Water Level in Ohio”: the
prediction tool

2) “Application Prediction Algorithm”: Python script for applying the algorithm. No
interaction required by the user, included for the model to reference and if the

user wishes to adapt the tool with a new algorithm.
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Double click, or right click and select ‘open’, on the prediction tool to open it in the

Geoprocessing tab, also shown in the screen shots of Figure 11.

BEefe-c-* ArcGIS Pro - ModelTemplate - Cat
) o " & }l o J}E + Dd I‘E'j * t X ;l:‘hnpeﬂ > Bxpont (V] Show Details Panel E; Display Type *
ey v [_l T / | 4 (5 Coy M Upgrade ~ Search My Organaation T Default Sort toF "
te E“" ARKY goctmaks Go | Basemap Add  Add | Select paste 2 CoRY New Delete Ede % UPY My Org: £
- (& CopyPath - o < Dota~ Presets - - (@ CopyPath B Saveds - 7] Show Pog-ups More Detaid toSt "
Clipboard Nangate w Layer Clipboard Organize Metadata Options Stytes
Catalog <% x i Caog  [EJNGE Contents -3 J Map
/

Project | Portal | Favorites | Histor: 4 [ Project » Tockoxes » ModelTemplate.thx

O Mops Name Type
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o Tobons ¥ Application of Prediction Algorthm Script
S 4
3 Model for Predicting Points of Post-Mining Water Level Ohso  Model
Gl Databases ing ng
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o Layouts ¥
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@ Folders
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Layouts Batch
o 52 & My Content
b Shle ® c
ty 2 Groups B co
b ot Folders
3 All Portal X Delete
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- {2 Living Atlas
Favorites 7/ Edit Metadata
B Properties
@ o Bt Catalog  Contents  Element 2Mems 1 Item Selected

Figure 11 — Screenshots displaying how to locate the prediction tool within the Project toolbox. Both screenshots are different
ways of finding the toolbox within the Catalog window.

5.3 RUNNING THE ToOL

With the tool open, options for inputs and model-generated outputs are displayed with the
defaults. Figure 12 shows the layout of the tool when opened in the Geoprocessing window.

See previous Section 3 for more details.
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Figure 12 — Screenshot displaying how the tool looks when opened in the geoprocessing window, with the user required inputs
labeled at the top, final required inputs with defaults, and outputs labeled at the bottom.
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The User Inputs are items that need to be changed by the user before running the tool.

‘User Inputs’ from the user are:

1.) Working Folder: user MUST select the project folder where the toolbox and

geodatabase are stored for the tool to run (Figure 13).

Input: Working Folder

G D|E

Organize * New ltem

4 & Pproject Nome Type

[ Foiders 1 | 78 Mine_Pool_Prediction Model Map_F8X _Folder Connection

4 [ Computer

Desktop

Documents

Example_Proposed_Mine
Input: Pre-SMCRA Mines
AUM_Mines

Input:Post-SMCRA Mines
UG_Mines

Input: DEM
DEM

Run »

4,652.30€ 4,467,182.75N m 2 Cstalog Geoprocessing | Symbology

Figure 13 — Screenshot showing how to select the project folder for the User Input “Working Folder”. The folder only needs to be
clicked on once to highlight/select it but not open it. Once highlighted, hit ‘OK’.

2.) Well Excel Sheet: .csv formatted sheet that user has added to the map (Figure 14)
3.) Borehole Excel Sheet: .csv formatted sheet that user has added to the map (Figure 14)
4.) Proposed Mine: shapefile of proposed mine extent that user has added to the map

(Figure 14)
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Geoprocessing >4 Xx

(®© Model for Predicting Points of Post-Mining Water Level... =

Parameters | Envirormerts @
Input: Working Folder
| %Workspace% |-
(D Input: Well Excel Sheet
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D2177_well_pts.csv -]
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Bxample_Proposed_Mine ==
AUM_Mines
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INPUEPost- SMCRA Mines
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Input: DEM
(o .
Output: Wells
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| borehole.pts | -
Output: Calculated Points
|cole.pts |-
Output: Calculated Points vs DEM
| cale_pts_Spatialloin | -

Catalog Geoprocessing  Symbolegy

Figure 14 — Screenshot of the prediction tool open in the geoprocessing window. To select the files for each user input, files
already on the map can be seen in the drop down menu when clicking on the small arrow on the right of the input row. Select
the appropriate file for each ‘Input:’
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‘Included Default’ inputs are pre-loaded and Ohio Coal field users need not change unless
these files have been updated by ODNR (Figure 12). They can also be changed as displayed in

Figure 14 if shapefiles have been added to the project map:

5.) Pre-SMCRA Mines: recent underground mines layer from ODNR
6.) Post-MSCRA Mines: abandoned underground mines layer from ODNR

7.) DEM: digital elevation model in meters for area of proposed mine, state of Ohio DEM

'Outputs’ are pre-set with default names and a default location of the scratch geodatabase.
The user should change the names and locations of the outputs to the project geodatabase so
that the outputs can be easily located and identified. If not changed, re-running the model will
replace the previous results. Changing the name allows for identifying between runs results.
The main outputs will be added to the map once the tool is run even if the user does not
change the name. Figure 15 shows how to select the geodatabase location to save user outputs

of the model.
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Save Cancel |

Run >
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Figure 15 — Screenshot displaying where to save output shapefiles of model. Open the window to navigate to the project
geodatabase, enter a name for the shapefile, and hit ‘save’ at the bottom. This example is for the output well points shapefile,
but should be done for the next three output shapefiles.

Once all the data is correctly entered in the geoprocessing window of the model, hit ‘run’ at

the bottom of the window to start the model. Allow ArcPro time to run through the model, it

will add layers to the map and display a successful run (Figure 18).
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Catalog Geoprocessing Symbology

Run »
» (» Model for Predicting Points of Post-Mining Water Level Ohio
Executing Clip... @
ey
Catalog Geoprocessing
Run (>

> + Model for Predicting Points of Post-Mining Water Level Ohio
Completed successfully

Catalog Geoprocessing

Figure 16 - Screenshots displaying running the model. At the top start with clicking run once all data is entered, next screenshot
displays the tool running, the bottom screenshot displaying that the model has run successfully.

5.3.1 Metadata
Descriptions for each input and output can be seen in the metadata when viewing the tool

in the toolbox (Figure 17).
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] Catalog X Map v

@ - @“E‘ » Project » Toolboxes » TestTempMap.thx b ‘O| | Search Project b ‘E
N T s 3 = S

o e Model for Predicting Points of Post-Mining Water Level Ohio ~

Application of Prediction Algorithm Script
| gbﬂ Model for Predicting Points of Post-Mir  Model

Title Model for Predicting Points of Post-Mining Water Level Ohio

Description

Model for predicting post-mining water levels at well locations for underground coal mines in Ohio.
This tool extracts variables from input data and uses the accompanying python script to apply the
prediction algorithm specific to the geology and hydrology of Ohio's coal fields.

Usage

TF

Syntax

ModelPredictionPointsWaterLevel_ (Input_Working_Folder, Input_Well_Excel_Sheet,
Input_Borehole_Excel_Sheet, Input_Proposed_Mine, Input_Pre_SMCRA_Mines,
Input_Post_SMCRA_Mines, Input_DEM, Output_Wells, Output_Boreholes, Output_Calculated_Points,
Output__Calculated_Points_vs_DEM)

Parameter Explanation Data Type

Input_Working_Folder Dialog Reference Folder
Working_Folder is the location of the working
folder for the project that contains the
project geodatabases. This location is used
for outputting tables used in running the
algorithm script.

Input_ Well_Excel_Sheet Dialog Reference Table View
Well_Excel_Sheet is a csv file created by the
user from the provided Excel template that
contains georeferenced mine permit well
data that will be used as locations for
predicating post-mining water levels. The
order of the data entered by the user in this
sheet is required to match the template
format for the model to run correctly.

Metadata | Preview
2 ltems 1 Item Selected @ &)

Figure 17 — Screenshot displaying how to view metadata of the tool when viewing the tool in the catalog window. Figure 11
shows how to navigate to this window.

The metadata can also be seen by clicking on the question mark when viewing the tool

in the geoprocessing window (Figure 18).

Geoprocessing v X
(© Model for Predicting Points of Post-Mining Water Level... =
Parameters | Envirorments

Input: Working Folder

Figure 18 — Screenshot of how to locate the ‘question mark’ in the geoprocessing window of the model. Clicking on the question
mark opens another window displaying the metadata of the model.
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5.4 INTERPRETING ToOL OUTPUTS

The final outputs of the tool are automatically added to the map when the model
successfully runs, but are also saved to the location specified by the User in the set up for
running the tool (Section 5.3). The shapefiles added (and default names) to the map by the tool

are:

1) Projected well points (well_pts.shp)
2) Projected borehole points (borehole_pts.shp)
3) Calculation points with all variables extracted (cal_pts.shp)

a. All variables required to run the prediction algorithm are displayed in the
attribute table, along with the final column providing the predicted post-mining
water level

4) Calculation points with comparison to the area DEM (calc_pts_Spatialloin.shp)

a. Resulting attribute table displays values for the initial measured potentiometric
head, calculated coal seam elevation, value of predicted head, DEM points
converted to feet, and the final value comparing the surface elevation to the
predicted head (Figure 10). Note: The elevation used for comparison is the DEM

elevation, not the reported surface elevation from the initial well input data.
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Figure 19 — Screenshot of final outputs from running the prediction tool, highlighting a point of risk that when clicked displays
the data results in a pop up window.
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Once the tool has been run and layers are added to the map, symbology for interpreting

the layers can be edited to easily identify which well points of predicted post-mining water level

indicate areas at risk for surface discharge.

This can be done by right clicking on the ‘calc_pts_Spatialloin’ layer and selecting

‘Symbology’ to open the symbology tab, or by clicking on the layer to highlight it and the

symbology tab appears in the header tab of ArcGIS Pro (Figure 20).
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Figure 20 — Screenshots to display how to locate the symbology function for the final output layer. The left image shows right
clicking on the layer in the table of contents. The right image shows when the layer is highlighted (one click) in the table of
contents the main ribbon tab for ‘Feature Layer’ > ‘Appearance’ > ‘Symbology’> ‘Graduated colors’.
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Once editing the symbology, there are various ways to display the point data but the
suggestion for tool users is to define symbology for value ranges of points below the DEM
(positive “Dist to Surface from Predicted Head” values) and above the DEM (negative “Dist to

Surface from Predicted Head” values), by following the steps below.

At the top of the symbology tab, select ‘Graduated Colors’ as the type of symbology (Figure
21 [#1]). Then select the “Dist to Surface from Predicted Head” as the value to be symbolized by
and pick 2 for number of ranges (Figure 21 [#2-3]). Ranges will be automatically assigned but
can be edited by double clicking in the range box. Enter ‘0’ in the first box to indicate points
that have a negative value indicating water level above the DEM (Figure 21 [#4]). The second
box should already be the highest value, thus representing the values below the DEM. The
symbol on the left can then be double clicked to change the size and color of the points to

indicate on the map areas of risk for surface discharge (Figure 21).
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Figure 21 — Screenshots displaying how to adjust the symbology for the final output layer. 1. Selecting the ‘Graduated colors’ for
symbology type. 2. Select field to symbolize by, the final value that compares the predicted head to the DEM: ‘Dist to Surface
from Predicted Head’. 3. Select 2 for the number of classes. 4. Manually change the upper value for the lower of the ranges to 0.
Finally, double clicking on the actual symbol will allow the next window to appear where the user can select shape, size, and
color for each of the different ranges. Make sure to ‘Apply’ the symbology.
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6.1 POINTS NOT PROJECTING CORRECTLY

If the model runs well but the resulting points are not in the area of the proposed mine as

they should be, it is likely the default projection of the tool does not match the projection of

the input data’s XY coordinates. This may be fixed by setting a projection in the Environment of

the tool prior to running (Figure 22). If the data is in a latitude longitude format the data will

need to be converted to XY coordinates.
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Figure 22 — Screenshots showing how to set the coordinate system in the environments settings for the prediction tool so that it
matches the user’s data. The most common ones used in the applicable area of the tool are highlighted on the left.
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6.2 MODEL FAILURE

The most likely error to occur is that user data was not input correctly and has caused the
tool to fail. The first suggestion is to re-check the data entered in the Excel spreadsheets. None
of the values should be zero or null values. The units of the entered data should also be
checked so that they match the required units for the tool, as indicated in the Excel templates
and in the previous descriptions in this User’s Guide. Another possibility is that the ‘Working
Folder’, the first input required when viewing the tool in the geoprocessing, was not changed

from the default value; the tool cannot run without this section.

6.3 MODEL OUTPUT VALUES UNREASONABLE

If the results from running the tool provided highly unreasonable values, the first
suggestion is to re-check the data entered in the Excel spreadsheets. None of the values should
be zero or null values. The units of the entered data should also be checked so that they match
the required units for the tool, as indicated in the Excel templates and in the previous
descriptions in this User’s Guide. If the units are correct and the data has no nulls or incorrect
zeros, it may be that the users’ data is not accurate, or the algorithm is not applicable to the

area the data was collected for.

6.4 MODEL INVALID WHEN OPENED

If when opening the tool in the geoprocessing tab, it initially displays a red x and states
the ‘model is invalid’, it is likely there is a connection lost in the model builder structure of the
tool. There is the possibility with inconsistencies of Model Builder that the tool itself may break
down. One common issue in testing the tool was losing the connection to the tool that runs the
prediction algorithm that is included in the flow of Model Builder. The Python script that runs
the variable transformations and applies the prediction algorithm is included in the project

toolbox, as described in Section 5.1.

To fix this issue, simple editing will have to be done directly to the tool in Model Builder.
To open this, view the tool in the Catalog view of the toolbox, right click and select ‘edit’ (Figure

23).
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Figure 23 — Screenshot showing how to open the editing window for Model Builder.

This will open an editing window of Model Builder that may look like the screen shot in Figure

24.
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Figure 24 — Screenshot showing what the tool looks like in Model Builder if the connection to the algorithm tool is lost.

Once open, if the model looks like Figure 15, select the ‘Application Prediction Algorithm’ and

hit delete (Figure 25).
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Figure 25 — Screenshot showing how the tool looks once the lost connection is deleted, done by highlighting the ‘Application
Prediction Algorithm’ and hitting delete.

ifi -

From the Catalog window, open the toolbox and drag the script tool ‘Application Prediction

Algorithm’ into the open Model Builder window (Figure 26).
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Figure 26 — Screenshot displaying dragging the ‘Application of Prediction Algorithm’ from the toolbox viewed in the Catalog
window in to the open editing Model Builder screen.

Next, the connections to the model and the script tool must be repaired (Figure 27). Click and

drag from the ‘editing_table.csv’ variable to the ‘Application Prediction Algorithm’ and select
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the option for Input Table. Next click and drag from the ‘Input Working Folder’ and select the
option for “‘Working Folder’. Finally connect the ‘output.csv’ variable to the rest of the model

‘XY Table to Point’ and select the option for ‘Input Table’.
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Figure 27 — Screenshots displaying how to repair the connections of the model to the ‘Application Prediction Algorithm’. Click
and drag from the ‘editing_table.csv’ to the ‘Application Prediction Algorithm’ and select the option for Input Table. Next click
and drag from the ‘Input Working Folder’ and select the option for ‘Working Folder’. Finally connect the ‘output.csv’ variable to
the rest of the model ‘XY Table to Point’ and select the option for ‘Input Table’.
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Once the connections are repaired, the final fix is to open the ‘Application Prediction Algorithm’

and change the output table name and location (Figure 28). The output table MUST be a .csv

file format. The default name can be left but add .csv at the end and select the project folder

location (NOT a geodatabase).
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Figure 28 — Screenshot showing final repairs to the model. Once the tool is reconnected, double click to open ‘Application
Prediction Algorithm’ to edit the output table name and location. The output table MUST be a .csv file format. The default name
can be left but add .csv at the end and select the project folder location (NOT a geodatabase).

Once this is done the model should look like Figure 29. Save the model before closing the

Model Builder edit window and re-run the model.
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Figure 29 — Screenshot of the final repaired model for the prediction tool. Make sure to save the model before closing and re

running.



